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ARGES Ammonium Sensor Manual

Product Overview

The ARGES Ammonium sensor is a submersible selective ion sensor built for taking sustained measurements of dissolved Ammonium
levels in water sources such as rivers and lakes. The sensor is manufactured from high grade PVC tube, fitted with a wet mate network
connector, and is designed to conserve power, making it ideal for remote operations. It can be used standalone or as part of a
multiparameter system (such as the ARGES SONDE). Like all of the ARGES selective ion sensor range, it has a built-in temperature
sensor for measurement correction that can also be used to record the sample temperature.

The sensor is user configurable and supports the SDI12 V1.4 protocol.

Product Images

This is a photograph of the Ammonium Sensor, featuring a sleek black finish with its name prominently displayed for easy identification.

Figure 1 Figure 2 Figure 3 Figure 4

QLOG Applications Software

The ARGES Ammonium sensor is supplied with a copy of the QLOG applications software. QLOG gives the user the ability to make
configuration changes, take measurements, display real-time measurements and store results in spreadsheet format CSV text files for
easy analysis.
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The images above show real-time measurements of Ammonium in a series of panel meters and charts.
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Ammonium Sensor Technical Features

Solid state ISE sensor

Measurement Range 0.9 - 9000 ppm - auto ranging - User defined range
Resolution: 0.01 - ppm (Parts per million)
Interference IONS Volatile Amines
Calibration 40 Hours measurement time - recalibrate before deployment.
Operation Stand-alone / multiparameter solutions.
Sensor life: 2 years
Sl Units: ppm, mg/l, mol/dm?, °C -- temperature compensated measurements
Integrity Built in serial number / Latest Calibration Date
User Range User defined sensor range - Maximum / Minimum
pH 0.0-85
Interference IONS Volatile Amines
Standby Current 12V DC 6 mA - Typical
Table 1

The calibration procedure used with the Ammonium sensor follows the same procedures as described on page 9 for all of the ARGES
range of selective ion sensors. The easiest way to calibrate a selective ion sensor is to use the free QLOG software and set the sensor
to calibration mode. Full calibration details are shown on page 14.

Measurement Integrity

A solid state sensor makes measurements using reference and selective ion half cells and is suitable for long term submerged
operations. For best results it should be deployed into slow moving or stationary water.

The ARGES Ammonium sensor is factory calibrated at 2 points, which should bracket the expected value for Ammonium concentration
in the water. Selective ion sensors cannot be calibrated at a zero point, even with deionised water.

The ARGES Ammonium sensor is factory set to provide readings in ppm at the raw sensor temperature, and compensated readings
based on the calibration temperature.

where
1 ppm =1 mg/mL
1 ppm of Ammonium =2.17E-05 mols/dm?

User calibration features are included in the QLOG software supplied with this sensor.

Best Measurement Practice

All selective ion sensors such as the ARGEs Ammonium sensor supply the most accurate measurement when deployed in still, or slow
flowing water sources.

Avoid fast flowing water sources as this will cause an error in the measurements. Selective ion sensors will report a lower level
measurement when used in fast flowing water sources.
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Measurement Variables
The following variables are available for use with the Ammonium sensor.

The user can adjust the order and measurement variables being sent out from the sensor. Additional concentration parameters can be
added to the sensor on user request.

Letter Description Name Units
Main Sensor Readings
A Raw Concentration Output ppm
B Raw Concentration in mg/mL mg/mL
C Raw Concentration in mol/dm? mol/dm?
E Raw Chemical Sensor Reading millivolts
G Temperature Compensated Concentration ppm
H Temperature Compensated mg/mL mg.mL
Temperature Compensated mol/dm? mol/dm?
M Temperature °C
Table 2

Variable Selection

The flow chart below shows the parameters from Table 2 and how they are calculated and referenced
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Default Output Parameters : AMGE
Where:
A = Uncompensated concentration in ppm M = Sample Temperature in Deg C
G = Temperature compensated concentration in ppm E = Raw sensor reading in millivolts.
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|87 Edit Sensor Configuration 7 X
Property Value tool Set

dentify 14KEYMESCOISELECT1TAmmoDDi3
Probe Type Ammo Tool Set
Serial number 0003 Tool Set
Minimum underrange 0.010000 Tool Set
Maximum overrange 2000.0 Tool Set
Output variables AMGE Tool Set

Figure 8 - Output Parameter Selection - Sensor Configuration Window QLOG - Output AGME

Communications with Windows PCs Using SDI12

The simplest way to configure and take measurements with the sensor is with a USB-SDI12-AG1 media converter connecting the
sensor to a windows device, and using the free QLOG software downloadable from the Keynes Controls website.

Equipment Required:

1. USB-SDI12-AG1 Figures 9-12, USB to SDI12 media converter for use with the ARGES chemical sensors
2. USB Cable Figure 13, Type 2.0 Male A to Type Male B cable
3. ARGES Network cable Figure 16
4. ARGES Extension cable Figure 15
Software

Use the Keynes Controls QLOG software

Download a copy from the www.keynes-controls.co.uk website and install onto a Windows Operating system computer.
The software should run on Windows XP, 10 and 11 operating systems.

The software can be used without restriction. Any similar software that supports SDI12 network operations can be used instead.

Figure 9 Figure 10 Figure 11 Figure 12

Figures 14 and 16 show the network cables used with all ARGES chemical sensors.

Figure 13 USB 2.0 Type A Male to Type B Male Figure 14 Figure 15 - ARGES Sensor network extension cable Figure 16 - ARGES Network Cable
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Figure 17 ARGES Ammonium Sensor Figure 18 - ARGES network cable attached to the Ammonium sensor.

Hardware Installation

The cables used with the ARGES Ammonium sensor, media converter and network cables can only be fitted together in a single
combination. It is not possible to connect the instrumentation together incorrectly.

1. Connect the USB cable into the base of the USB-SDI12-AG1 media converter. See Figures 10 and 13 on page 3 above.

2. Connect the orange extension cable or ARGES network cable to the blue binder connector on the USB-SDI12-AG1 media
converter. See Figures 11 and 12 on page 3, or 18 and 19 below.

Network cable connection to the USB-SDI12-AGI media

converter.

Figure 18 shows the network cable alignment to the
USB-SDI12-AG1 media cable.

A white marker on the Blue Binder connectors has to
line-up for the cable to push onto the media converter.

— Figure 19 shows the network cable terminated onto the
media converter.

Figure 19 Figure 20

3. The black ARGES network cable shown in figure 16 above, is waterproof and safe for submergence with the Ammonium
sensor. It is terminated with a moulded 5-pin connector that fastens to the sensor and a blue IP68 rated Binder connector.

The 5-pin sensor terminating socket on the network cable is moulded into the cable end and ensures high integrity and reliable
connection. The moulded socket is wet mate capable.

The orange extension cable is terminated with Binder IP68 plugs.

4. Terminate the ARGES network cable to Ammonium sensor. It only fits one way onto the gold connector at the rear of the sensor.
See Figure 20 below.. Lock into place on the sensor using the red securing ring.

5. Using the USB interface cable, Plug the USB type A socket into a standard USB port on the Windows PC. See Figures 9 and 13
on page 3 for more details.

As long as the Windows PC is powered on, and the USB port is operating to the correct technical specification then the blue
status LED on the USBSDI12-AG1 media converter will illuminate. See Figure 12 on page 3.
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Figure 21 - ARGES Network Cable Figure 22 - ARGES Network Extension cable

Powering the ARGES Ammonium Sensor

The ARGES Ammonium sensor is powered directly from the PC USB port via the USB-SDI12-AG1 media converter. This makes
measurements and calibration operations very easy. A Windows laptop can supply enough power through a USB port to power any of
the ARGES Sensors.

The USB-SDI12-AG1 media converter can power single sensors and multiparameter systems directly from the PC USB Port.

Figure 23

USB-SDI12-AG1 Device Drivers

The device driver software for the usb media converter automatically loads into the PC so long as an Internet connection is made. The
media converter uses the FTDI chipset and the driver software that is usually already part of Microsoft Windows.

Plug the USB cable supplied with the USB-SDI12-AG1 media converter into a windows PC. The blue status indicator visible in figure 20
will switch on to indicate that the chosen port is operating correctly.

Further Information
All items shown in this document are available from the Keynes Controls online shop.

See keynes-controls.co.uk for details, or E-mail sales@keynes-controls.com
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Pin-outs
The pin-out is standard on all of the ARGES range of chemical sensors.

View looking into the sensor connector.

Figure 24
1= -RS485 2=+ RS485 3 =SDI12 Data 4= Gnd

Downloading QLOG

A free copy of QLOG can be downloaded from https://keynes-controls.co.uk/g-log-software/.

QLOG Software Quick User Guide

5=+12V DC

The ARGES Ammonium sensor supports multiple digital communication networks. This manual only considers using the SDI12 network

for communications using the USB media converter and QLOG software.
Required Information:

1. COM Port used by the USB-SDI12-AG1 media converter.

Use the Device Manager feature of the operating system to locate the USB-SDI12-AG1 COM port number.

3 Qlog Recorder - o x| Enterthe USB media converter COM port number into
' the QLOG Software Configuration Window.

n 17 Logging C ? X

Devicelist | Varisblelist | Formulss  Alarm Level

- — conie [EEE — = The QLOG software has to identify the media converter
B e 5 - = so the sensor measurements can be read.
2 |8 Logging Interval lm;[
j ; FeName Select QLOG - Configuration menu option
[ososti e
5 |E
U JF = The Window opposite will appear. Select the COM port
1]e e fon -l number from the pull down list. In the example COM
rt o L port 3 has been selected.
10 ) u

[Q0GVer: 024 02Capyright Ky nes Contiod: Y2012 2071 . S 4

Figure 25 - QLOG Configuration Window

Network Selection

The ARGEs Ammonium sensor automatically detects the network on which has been connected by reading the network traffic.

The USB-SDI12-AG1 media converter used with the ARGERS Ammonium sensor only supports the SDI12 network. Upon connecting

the media converter to the instrument then the SDI12 network will be activated.

Select SDI-12 menu option from the pull down list. See Figure 25 above.
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Recommended Sample Rate
1. A single sensor connected directly to a PC or similar data acquisition system
Maximum sample rate 1 Second
Recommended sample rate 10 Seconds
Once all the configuration settings have been assigned press the ‘OK’ button to store.
The slower the sample rate, the longer the sensor will last before recalibration is required.
Multiparameter Housing Sample rate
2. The fastest sample rate for a fully populated 7 Port SONDE is 10 Seconds
Recommended sample rate is 30 Seconds.

It is now possible to scan the network and identify the sensor

Scanning the SDI12 Network

Select F9 on the PC keyboard, or select ‘Scan for Devices’ from the QLOG menu system

o | R —

'QLOG Ver. 2024002Copyright Keynes Controls (C) 2012:2024

Figure 26 Figure 27

The USB-SDI12-AG1 media converter status indicators will flash on and off, see Figure 27 above.

Identify the Ammonium Sensor in the SDI12 Network.

The SDI12 network supports 10 sensors each with an individual ID number for identification. The SDI12 ID number is an integer ranging
from 0 to 9. Each sensor has a unique ID address, and supports an enhanced address mode to allow additional devices on the same
network.

Each sensor also has an Product Description string, in the case of the Ammonium sensor this is

a14KEYNESCOISELEC117Ammo0003
This has been assigned by Keynes Controls Ltd and is a standard feature of the SDI12 protocol.
Where:

a = ID number of the sensor
Factory Default settings:

ID = 0 for all sensor types

Once the Ammonium sensor has been identified on the network then it will appear under the Device list tab in the QLOG Software, see
figure 28 below. The ID number of the sensor may vary depending on configuration.
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7 Qlog Recorder - 0 x Figure 28 opposite shows a Ammonium
o ey B G I sensor with ID 4 on the SDI12 network.

Device List | variable List | Formuias | Alarm Levels

List of devices

P j

[

4 411414KEYNESCOISELECT17Amme0003 |ARGES Ammenium 1M Setup | Config | IDv14)

I’ |
Logging N Stopped at 18:16:55

Figure 28 - Device List after a network scan

Figure 33 shows a typical network scan when multiple sensors are being used and has identified a Ammonium sensor. The QLOG
software does not yet understand what has to be done with the measurements that will be returned from the sensor or sensors.

Note. The 4th column shown in Figure 28 shows the cell locations where the measurements will be stored in the results file.
The QLOG software uses the same cell references as common spreadsheets.

The Ammonium sensor above is shown storing measurements into cells | .. M.
Use the Auto-assign option in the main QLOG menu option to enable software to automatically adjust the cells.

The first three cells referenced A..C are reserved and cannot be used by the User. The cell references are the same as those used by
most spreadsheet programs.

Understanding the Sensor Parameters
An SDI12 sensor can return multiple measurements back to the PC or any other data acquisition system controlling the network.

The QLOG software has to be told which measurements the ARGES Ammonium sensor will be sending to the PC in order to make
sense of the results.

The ARGES Ammonium sensor is preset to return the following values::

Raw Ammonium Concentration ppm
Sample Temperature °C
Temperature Corrected Ammonium concentration ppm

Raw sensor reading millivolts

Ammonium Measurements

Select the ‘Setup’ Button. See column 4 in Figure 29.
D.H Setup | Config | IDv1.4
1M Setup | Config | IDw1.4
MR Setup | Cenfig | IDv1.4
Figure 29

The Device Setup Window shown in Figure 30 will appear.

{3 Device Setup X Figure 30 opposite shows the QLOG device setup window for the current Ammonium sensor.
T Select the ‘OK’ button.
Configuration
Jammonium sevscr 5| Ensure the ‘Ammonium Sensor’ option is shown in the Window. Adjust with the pull down menu option
StartCoumn as necessary.
3 =l

The Start column into which the measurements are to be stored is defined under the ‘Start Column’ tab.
In the example the cell location is shown as ‘A’. This can be adjusted. Any cell after D required.

The Auto Assign function will assign the correct cell location for measurement storage automatically.

Figure 30 - Ammonium Device Setup Window
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Once all the sensors on a network have been identified and set the cell locations for the measurements
can be automatically assigned.

Repeat for all sensors on the network.
Once the Ammonium sensor has been identified then the measurements can be stored into the results file

Using the menu system shown below

| i |

Scan for devices

Select ‘Auto Assign’ menu option.

Start Logging The menu is also used to start and stop the data acquisition operations, change the sensor ID, etc.
Stop Logging

TR The QLOG sensor can now be used to make measurements. Everything is configured.
ManualCommand

Auto Assign
Save

GSM

Import/Export
Figure 31

The sensor will return four parameters after each measurement: raw Ammonium reading (ppm), sample temperature (°C),
temperature-corrected Ammonium concentration (ppm), raw sensor reading (mV).

71 QLag Recorder N o x | Once the Auto Assign function has been
Qlog View Edit Help activated then the cell references used by the
. different sensors are automatically assigned.
Devicelist ~ VariableList | Formulas | AlarmLevels |
Col Variable Name Units Cunrent f.' Figure 33 opposite shows a Device List for a 3
G [Intemal temperture(3) 0143 Port multiparameter SONDE with a Ammonium
H 0
sensorsetas D4 .
| Ammonium (raw) Ammonium; ppm 17.0246
il Ammonium Ammonium-Temp; Deg-C 17.44
K Ammonium (Comp) Ammonium Comp; ppm 2048
L mV_main cell millivelts current; mV 217.84
M 0
N Internal Units(5) 18.762 -
LoggingV  Current record:d at: 18:52:45  Next Log 18:52:50
Figure 32
{87 Olog Recorder — ] X
Qlog View Edit Help
o
DeviceList | Variable List | Formuias | AlarmLevels [
List of devices
31!314KEYNESCOFLOURS018CDOMO002 CDOM/FDOM sensor D.H Setup | Config | IDv14
411414KEYNESCOISELECT17Ammo0003 /ARGES Ammonium l.Mm Setup | Config | IDv1.4)
5I'514KEYNESCOFLOURSO18Turb0002 [Turbidity N.R Setup | Config | IDv1.4)
I B
Logging¥  Cumentrecord:73 at: 19:04:15  Next Log 19:04:20

Figure 33
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Real-time Measurements

Scan for devices

Start Logging

Step Logging

Change Address

ManualCommand

Auto Assign

Save

GSM

Import/Export
Figure 34

7 Qlog Recorder
Qlog View Edit_Help

In order to observe measurements from the

Ammonium sensor, select the ‘Start

e | e s e

Col Variable

Name.

Units

Current

Internal temperature(3)

0143

]

Ammonium (raw)

Ammonium;

pom

17.0246

Ammonium

Ammonium-Temp;

Deg-C

17.44

Ammonium Comp;

pom

2048

mV_main

cell millivolts current;

mv

21784

]

G
H

|

)

K | Ammonium (Comp)
L

M

N

Internal Units(5)

18762

L

Logging ¥ Current record:d at: 18:5245 _ Next Log 18:5250

Logging’ option.

The status indicators on the
USB-SDI12-AG1 indicator will flash as
measurements are sent from the sensor.

The light level shown is the background
level at the time of measurements.

Figure 35 - Measurements

Changing the sensor ID number

It is possible to change the sensor ID number using the QLOG software.

The simplest way is to use the Change Address option from the QLOG software.

Select the ‘Change Address’ option as shown below.

Configuration

Scan for devices F9

Start Logging F2

Stop Logging F3

ManualCommand

Auto Assign

Save

GSM

Release Port
Figure 36

87 Change Device Address ?
From
| 4114 14KEYNES COISELEC 1 17Ammo0003 =
To
- set

Figure 37 - Change Address Window

Arges Ammonium Sensor Manual - Version 1.01
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The example shows the Change Window
configure to adjust a sensor with original ID of 4
toanew ID of 6

Press the ‘Set’ button to store the new ID.

The QLOG software will scan the network to
identify the sensor.

Make sure each sensor has a unique 1D
number.
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Calibration Solutions

Calibrating the ARGES Ammonium sensor requires two calibration solutions, which should bracket the expected value of the solution to
be measured. These solutions are most easily made from a base solution of 1000 ppm, which is then diluted down to the desired
concentration.

The following table presents the ratios to make a variety of concentrations of solution, as well as the masses necessary to make 200 ml
of solution at that concentration. Add the specified masses to 200 g of water.

lon Solute ppm Ratio Mass for 200 ml
Ammonium Ammonium Chloride (99% pure) 1000 ppm 1: 333 0.601g
Ammonium Ammonium Chloride (99% pure) 500 ppm 1: 667 0.300 g
Ammonium Ammonium Chloride (99% pure) 200 ppm 1:1667 0.120 g
Ammonium Ammonium Chloride (99% pure) 100 ppm 1:3333 0.060 g

Table 3

Base Concentration Calibration Solution
The base calibration solution is the one from which the lower calibration solutions are derived.
Using 0.136 g Sodium Ammonium in 100g of water gives a 971 ppm solution, from which the diluted calibration standards are derived.

Using these values will provide a solution with a concentration of 971+1 ppm so long as the Ammonium Chloride weight is measured
correctly using a chemistry scale.

Common range of Ammonium in UK rivers is within the range 0.1 to 100 ppm so the example demonstrates sample calibration levels.
Do not attempt a zero point calibration.

Additional Calibration details can be found at:

Calibration Solutions | Keynes Controls Ltd https://keynes-controls.co.uk/calibration-solutions/

High Level Calibration Solution

To produce a 500 ppm calibration solution, dilute the above 1000 ppm solution with an equal amount of deionised water (for example 40
ml of solution and 40 ml of deionised water).

Low Level Calibration Solution

1:999 dilution of the 1000 ppm standard calibration solution gives 1 ppm (for example, 1 ml of solution in 999 ml of deionised water).

Materials Required for Sensor Calibration
The Ammonium sensor requires the same items for calibration as all other sensors in the ARGES selective ion range:

High concentration calibration solution
Low concentration calibration solution
Beaker of distilled/deionised water

2 glass beakers

Temperature probe

Sensor stand (ideal but nonessential)
Magnetic stirrer (ideal but nonessential)

Arges Ammonium Sensor Manual - Version 1.01 Last Updated 08/2025
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Sensor Calibration

1. Set up the sensor on a stand as shown in figure 18 (page 6)
2. Ensure the sensor is connected to a Windows PC and communications are configured.

The calibration procedure used with the Ammonium sensor is the same as for the entire range of ARGES selective ion sensors. The
easiest way to calibrate a selective ion sensor is to use the free QLOG software and to set the sensor into configuration mode.

Make test measurements at the 2 calibration points. Record the raw values and sample temperature.

For normal river monitoring the calibration points mentioned above will be satisfactory for many applications. Once some idea as to the
levels of Ammonium in the water source is known then the sensor calibration factors can be adjusted to be closer in range for higher
accuracy results.

Clean the sensor in deionised water before sampling with the second calibration solution. Make sure the sensor is clean.

Use the temperature sensor built into the ARGES Ammonium sensor to give the sample temperature. When possible, calibrate the
sensor at the temperature into which it will be deployed. Once the sensor is deployed into the calibration solution, wait for the reading to
settle before recording the result.

Enter the raw Ammonium level as measured by the instrument at the known calibration level (ppm). In the example above this will be for
500 and 1 ppm calibration points. These levels give a good quality sensor reading at the levels expected for sample detection in the UK.

To enter configuration mode, press the Setup Button’ button adjacent to the sensor requiring configuration changes as shown in Figure
38.

b 4I414KEVNESCOISELECTI7AmmODOD3  ARGES Ammonium LM | Setup | Config [IDv1.4]

Figure 38

Calibration Certification

Callibration of the sensor and of the buffer solutions are available as optional extras.

Saving Calibration Information into the sensor.

To store new parameters into the ARGES Ammonium sensor simply enter the new parameter into the table and press the adjacent ‘Set’
button.

If using a Keynes Controls USB-SDI12-AG1 interface then the status indicators will flash briefly indicating that the new parameter has
been sent to the instrument.

|87 Edit Senser Configuration ? X
Property Value tool Set | =]
dentify T4KEYMESCOISELECT17Ammo0003

Probe Type Ammo Tool Set
Serial number 0003 Tool Set
inimum underrange 10.00000 Tool Set
aximum overrange 2000.0 Tool Set
Output variables AMGE Tool Set
olecular ion mass g/Mol 1.0000 Tool Set
Scale mag/L te ppm 5.5400E-5 Tool Set
First point millivolts 253.82 Tool Set
First point ppm 99.100 Tool Set
Second point millivolts 22113 Tool Set
Second point ppm 20.000 Tool Set
Secondary scale factor 1.0000 Tool Set
Tertiary scale factor 5.5400E-3 Tool Set
Calibration Temperature Deg-C 15.000 Tool Set
Temperature Correction mV/Deg-C -1.5500 Tool Set

\ =]

Figure 39 Ammonium Sensor User Configuration Window

Arges Ammonium Sensor Manual - Version 1.01 Last Updated 08/2025
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Sensor Configuration Parameters Terms

Minimum Underange

Maximum Overanage

Output Variables

Molecular mass

Scaling factor ppm to mg/L
Scaling factor ppm to mol/dm?

First point millivolt

First point ppm

Second point millivolt

Second point ppm

Secondary scale factor
Tertiary Scale factor
Calibration Temperature
Temperature Correction mv/°C

The minimum value that the sensor will return - Any measurement below this value will also
return at the minimum set level. eg Minimum underrange = 10 ppm then any reading less than
this level will show as 10 ppm.

This is the maximum value that the sensor will return - Any measurement above this value will
also be returned at the maximum set level.

User selectable outputs variables - Table 1 page 3 - Default = AMGE

Mass of the molecule in atomic units.

Typical value = 1.00 can be adjusted to allow for variations in density for dissolved ions.
Typical value = 5.54E-05

Raw sensor reading in millivolts with the sensor deployed into first calibration standard solution.
Example 99.1 ppm solution the sensor returns 252.82 millivolts

First point millivolt = 252.82

First point ppm = 99.1 ppm

Raw sensor reading in millivolts at 20 ppm calibration point = 221.13

2nd point calibration standard solution ppm = 20 ppm

Scalar number - used to calculate mg/I from ppm -

Scalar number - used to convert ppm to mol/dm?*® - useful for high concentration readings
Temperature for which the calibration was taken.

Variation in raw sensor millivolts with temperature change - can be a positive or negative value.
Table 4

ARGES Ammonium Sensor Configuration Settings

The ARGEs Ammonium sensor is fully user configurable. Figure33 above shows the Configuration Window for the sensor.

Setting the Ammonium Calibration Parameters

The sensor uses a 2 point calibration system to report measured concentration levels.

First Calibration Point
Second Point FLR (raw)

99 ppm calibration solution
20 ppm calibration solution

252.82 mV
221.13 mV

The value of 218.86 mv is the measurement reported from the ARGES Ammonium sensor in Manufacturer Setup Mode using a 20
ppm test solution. To store new parameters into the instrument configuration select the ‘Set’ button.

The ISE sensor requires two calibration points - a high concentration value and a low concentration value. It does not matter if the

values are entered high then low or low then high. It is not possible to use a 0 ppm solution for calibration, a nonzero low value must

be used.

Maximum Concentration Level

Maximum Overange: Sets the maximum level of measurement that the sensor can return

Maximum Overange: 2000 ppm

In this example a ARGES Ammonium sensor has a maximum range of 2,000 ppm before an out of range error message is returned.

See Figure 33 above. - this parameter can be adjusted on demand

The sensor will not return a value greater than 2,000 ppm.

Arges Ammonium Sensor Manual - Version 1.01
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Minimum Concentration Level

Minimum underrange: Sets the minimum level of measurement that the sensor can return
Minimum underrange: 2 ppm - Do not zero calibrate this sensor.

Note - Ammonium sensor will be set to operate from 2 to 2000 ppm only. Should the sensor be calibrated over the range 0 to 100 ppm
then the out of range message can be set to operate over the 0 to 100 ppm range.

In practice the sensor operates over a much lower range - 2 - 450 ppm.

7 Edit Sensor Configuration ? X
Property Value tool Set

dentify 14KEYNESCOISELECT17Ammo0003
Probe Type Amme Tool Set
Serial number 0003 Tool Set
inimum underrange 10.00000 Tool Set
aximum overrange 2000.0 Tool Set
Output variables AMGE Tool Set
olecular ion mass mg/uMol 1.0000 Tool Set

Figure 40

Typical Calibration Curve for lon Selective Electrode

Figure 41 illustrates the response (in voltage) produced by a selective ion sensor when measuring a solution of a given concentration.

Response

Log (Concentration)

Figure 41 - ISE sensor response graph

Arges Ammonium Sensor Manual - Version 1.01

A selective ion sensor is usually calibrated between two points
(example points here labeled P1 and P2) on the linear section of
the graph. Below a given concentration (the point labelled A on the
graph) the calculation becomes nonlinear, and a sensor expecting
to measure in this region will be calibrated differently. The ARGES
sensor cannot measure this out of the box, but can be set up to do
S0 on request.

Selective ion sensors have a lower limit on the concentration they
can meaningfully detect as the response asymptotically tends
towards a fixed value as concentration lowers.

The calibration points P1 and P2 are chosen to give good reliable
readings in milli-V at the calibration contraction levels.

For river water operations Keynes Controls typically calibrate the
sensor at 97 ppm and 25 ppm.

Where:
P1=91 ppm
P2 =20 ppm for the above plot.

Last Updated 08/2025
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Output Variables

The ARGES Ammonium sensor can be configured to return any of the variables listed in Table 2 above. The user has the ability to
adjust the measurement parameters being sent out by the sensor..

Figure 42 below shows a sample of the Ammonium sensor Configuration Window where the output variables are assigned.

|87 Edit Sensor Configuration ? *
Property Value tool Set

dentify 14KEYNESCOISELECT17Ammo0003
Probe Type Amme Tool Set
Serial number 0003 Tool Set
inimum underrange 10.00000 Tool Set
aximum overrange 2000.0 Tool Set
[Output variables AMGE Tool Set
olecular ion mass mg/uMol 1.0000 Tool Set

Figure 42 - ARGES Ammonium Configuration Window - Return Parameters
aM!aD0! AMGE - returns 4 values for the DO command.

A = Raw Concentration in ppm M = Temperature in °C
G = Temperature compensated concentration in ppm E = Raw sensor reading in millivolts.

aM!aD1! Command - returns 4 values for the D1 measurement command

Set the output variables to be returned from the sensor using the D1 command Sensor Serial Number.
The sensors have a factory set serial number.

Maximum data type: 16 x alpha-numeric characters.

Additional User Defined Output Variables

The aM!aD1! Command can be used to set additional parameters to be sent out by the sensor
4 user assigned variables are used with this command.

Assign the variables from the Table 2 shown in page 2.

Calibration Temperature

This is the temperature for which the calibration operations for the sensor were carried out. Under ideal conditions the calibration
temperature should be close to the deployment temperature for the chosen water source.

Units : °C
Callibration temperature : 18.850 °C

e e e s | e .

kahbraton temperature 18.850 | Tool Set

braveraio e [es nnn I

Figure 43 - Calibration Temperature Setting - Ammonium Sensor Configuration

Enter the calibration temperature and press ‘Set’ to store the new value into the sensor.

Arges Ammonium Sensor Manual - Version 1.01 Last Updated 08/2025
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Manufactures Probe Type ID

This is a sensor type as shown on the device list Window and cannot be user assigned.

Caring for the ARGES Selective lon Sensor

The ARGES selective ion sensors are precision instruments and should be treated with care. It is important that no trace of a previous
sample is left on the instrument as it can affect future readings.

1. Clean the sensor using distilled / deionised water and dry with a soft cloth.
Make sure the channel between the Ammonium half cell and the reference is clean before deployment.

2. Check that the 5 way connection fitted onto the top of the sensor is clean and free of debris/
Remove any debris found between the pins and wash with distilled water. Tap water can be used if required.

Should the sensor have been deployed into a heavily contaminated water source then soak the sensor in Isopropanol Alcohol. This will
kill any bacteria left on the sensor housing.

Figure 44 shows the head of the Ammonium sensor head.

The trench between the two sensors is where the conductive bridge will form and must be
cleaned and clear of contaminants.

Figure 44

Figure 45 shows the 5-Pin connector fitted onto the selective ion sensors.

Figure 46 shows the sensor fitted inside a multiparameter housing. A brush
unit can be used to clean the sensor heads between measure operations.

Figure 45 Figure 46

Remove the shade cap and clean the sensors fitted into a multiparameter
housing.

Use deionised water when possible. Dry with a soft cloth

Remove any contamination and detritus before redeployment.

Figure 47 - 3 x selective ion sensors inside a multiparameter housing.
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Dimensions

Figure 39 shows the dimensions of the sensor, which are the same for all ARGES selective ion sensors.
" £0.0 | 168.03 I

S —
&=

Pz

Figure 48
Length: 228mm
Width: 22mm

Sensor Deployment

Figures 49 to 51 show the ARGES Ammonium sensor prepared for direct deployment into the water source. Make sure the network
cable is attached and secured onto the instrument. The sensor can be directly connected to the USB media converter for use with a
Windows computer system. The sensor can be directly into a data logger using the SDI12, or RS485 communication networks.

Figure 49 Figure 50 Figure 51

Multiparameter Sensor Deployment

The ARGES Ammonium sensor can be fitted into a multiparameter housing. Use silicone grease on the
5 pin connector to ease the installation onto the housing socket.

The sensor can be fitted into any spare port in the housing. Secure the protective housing shade cap to the base unit
Once the network cable is attached the multiparameter sensor system can be deployed.

Fit the shade cap supplied with the
housing when deploying as a
multiparameter system into a water
source in order to protect the sensor
heads from damage and debris.

Figure 52 Figure 53

Arges Ammonium Sensor Manual - Version 1.01 Last Updated 08/2025
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Charts and Panel Meters

Example Configuration

The images below are taken from the configuration of a 3 port SONDE using

CDOM/fDOM sensor ID =3

Ammonium Sensor
Turbidity

ID=4
ID=5

The QLOG software can be configured to show real-time measurements on panel meters and charts as shown below

Select the ‘View’ tab from the main QLOG window to select the panel meter and chart options.
The charts support up to 2 Y axis parameters, so Ammonium and temperature values can be shown on the same plot.

. Chart of 20260123 1807.0t - o X 7 View Data _ o
Serest Seies2 Timespan VScale Live Colours &
Edit Links
0
9 1
" va
o7 19 Ammonium; ppm Ammonium-Temp; Deg-C
9 8
o wr
o 76 5
H
s &
ek
a5
w23
' o halindn
e d = - =
(I o [ (O
s . — — .
o 166
I 165
o2 164
o 163
.
ot 1000 o 1200 o1 1400 o1 1690 o1 1800 o1 2000
< Span 120 Hours >
8 Logging ¥ Current record:60 at: 1:41:15__ Next Log 19:41:20
Figure 54 Figure 55

Setting Up The Panel Meter Display

The QLOG software can present results in a series of User defined panel meters or charts.

The panel meter configuration is the same for all the different panel user assigned panel meter displays.

A typical panel meter display for the ARGES Ammonium sensor is shown above.

To configure the QLOG software panel meter then:

1. Start at the QLOG main menu - Select the ‘View’ Tab

It does not matter where or how the QLOG software

QLOG Software - View Tab Selection - Figure 56

Arges Ammonium Sensor Manual - Version 1.01
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/87 Olog Recorder - o X
| Otog [View Edit Help is configured, or what type and number of sensors
. are in operation.

Dev t 1 | Formdss | AarmLevels |

—  Chart2

L chens armbic Parme Urits Current j‘ The panel meter configuration is the same.

G Chartd Background Light; B-LUX

F Console

Il LCDPanels » raw) Ammonium; ppm

) Ammonium Ammonium-Temp; Deg-C

K Ammonium (Comp) Ammonium Comp; ppm

L mVY_main cell millivolts current; my

M

N birp Raw Turbidity; NTU

o tetrp Turbidity; NTU

P tempC Sample Temperature; Deg-C =l
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Select ‘LCD’ Option from the View Tab List.

Cha

Chart 2
Chart 3
Chart 4

Console
LCD Panels

Figure 57
A panel meter display will appear but it will require configuration to make it usefull. The display will be the last panel meter configuration
that was previously saved, or used on the Windows device.

3 view Do . - o x 1x2 Panel Meter Display - default
Ammonium; ppm Ammonium-Temp; Deg-C
e et
LU LLL

Number of Parameters to Display

Currently the panel meter can display up to a maximum of 32 individual parameters on a single display
However for most applications only several parameters from the sensors are required.

1. From the panel meter display select the ‘Edit’ Tab

Note. The panel specification is Column x Row. 2x3 = 2 Columns x 3 Rows.

W 2. Select the number of parameters that are to be displayed.
2x2)

3(1x3) The greater the number of parameters then the smaller they will appear

Mumber of panels * 42:) on the display.

6 (3x2)
Colours - 6 (2x3) Once the number of parameters has been defined then the panel meter

v Titles 9 (3x3) display will update to show the changes.

8 (4x2)

v Units 8 (2x4)

10 (5x2)

Save 10 (2¢5)

12 [@x3)
Refresh 26
16 (4x4)
32 (8x4)
32 (4x8)

Figure 60 Figure 61 - Panel List
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Selecting the parameters to be displayed.

1. Select the ‘Links’ tab on the panel meter a menu similar to that shown below will appear.

87 View Data

Edit | Links

Panel 1

. panel2 ppb Sample Temperature; Deg-C
[ Pone3
z qq qE lEqLiq
Panel — —) P l ) P
© Panel7
An Pancls p; ppm Ammonium-Temp; Deg-C
Panel
= lmomnn (C (1
Panel 11
Panel 12 u l u u l l u
0 .
© Panel 13
Panel 14
U ponelts NTU Sample Temperature; Deg-C
Panel 16
Panel 17 n I I n I 1
Panel 18 u l l u l -i
Panel 19 = = —

Panel 20
Panel 21

Figure 62

Choose Parameter

Repeat this operation for each parameter to be shown.

Parameter 1 is always the top left hand corner of the display.
In the panel opposite

Parameters selection is

Panel 1 Panel 2

Panel 3 Panel 4
Panel 5 Panel 6

Select ‘Panel 1’ and this will display a value in the top left hand 7 segment display - The Select variable Window similar to that shown

All the sensor measurements that are in use will be
displayed in a table similar to that shown opposite in Fig 63

Choose the parameter to be displayed

will appear.

B Select Variable N

Col Variable Name Units Select
A Record no. Sele
Oe Date Y/MD Sele
Oc Time himis. Sele
D |CDOM-raw CDOM-level; ppb Sele
JE |CDOM CDOM-Level; ppb-cal Sele
OF |tempC Sample Temperature; Deg-C Sele
G |lighttu Background Light; B-LUX Sele
OH Sele
| Ammonium (raw) Ammonium; ppm Sele
J Ammonium Ammonium-Temp; Deg-C Sele
K |Ammenium (Comp) Ammonium Comp; ppm Sele
oL mV¥_main cell millivolts current; my Sele
Om Sele
N  |btrp Raw Turbidity; NTU Sele
0o |tctrp Turbidity; NTU Sele
P |tempC Sample Temperature; Deg-C Sele
da |pklight Background Light; B-LUX Sele

Cancel
Figure 63

Once all the parameters are set then close the Select Variable Window

Arges Ammonium Sensor Manual - Version 1.01

Press the ‘Select ‘ button to confirm.
Example: select ‘Ammonium Compensated’ in cell J.
Press the ‘Select’ button and the current temperature

compensated value will appear in the panel meter.

Repeat the operation for all parameters to be displayed.

Last Updated 08/2025
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Saving the Panel Meter Configuration

In order to save the Panel Meter setup once it has been configured select the * Save’ menu option as shown in the figure below.

MNurnber of panels *
Colours 4
v Titles
v Units

Save
Refresh

SDI12 V 1.4 Features

In order to use the SDI12 V1.4 feature for any ISE type sensor ensure it has already been identified on the network and set up. See
page 9 Figure 28 above.

Id |4I!414KEYNESCOISELEC11?Amm00003 lARGES Ammonium |I..M | Setup | Config | 1Dwv1 .4|
Figure 64

The Window in Figure 41 will appear
Wait to allow all the parameters in the table to be downloaded from the sensor then press the ‘Update’ button.

The status LED indicators on a USB-SDI12-AG1 media converter will stop flashing once all of the parameters have been sent.

The ARGES Ammonium sensor will report the measu-rements into QLOG with the Sl units for area measurement automatically defined.

If a number of sensors are being used then activating the ‘Auto Assign’ option in the QLOG menu is recommended.

SDI12 V1.4 assigned Sl Units

& 5D12V1.4 Documentation r X The Sl units are preset into the sensor and will automatically assign
G B poed || T2l R 0>l & themselves in measurement operation.
AIM_001! § 4IM_00114 Ammonium (raw),ppm,Ammonium; |8 Ammoni... | Ammenium; ppm
4IM_002! | 4IM_002/4 Ammonium,Deg-C Ammenium-Te... |9 Ammoni... Ammonium-Temp; Deg-C The sensor can output Concentration in the fo||owing units_
4IM_003! | 4IM_00314, Ammonium (Comp),ppm,Ammoni... |10 Ammoni... Ammonium Comp; ppm
4IM_004! | 4IM_004!4,mV_main,mV, cell millivolts current, |11 mV_main | cell millivolts current; | mV ® ppm
e mg/L

e mol/dm?

2IM_006! | 41M_00614

4IM_007! | 4IM_00T!4
anaoost | av_oosis Temperature will always be given in °C.

2IM_009! | IM 00914

1
2
3
a
5 |am_00s! |am_oosia
6
7
B
9

10|4IM_010! | 4M_01014

Update Cancel

Figure 65 - SDI12 V1.4 S| Units
The ARGEs Ammonium sensor supports the SDI12 V1.4 protocol and as such supplies measurements directly in S units.
The Sl units for the Ammonium sensor are shown in Figure 43 above.

To store any changes into the sensor select and press the ‘Update’ button.

Arges Ammonium Sensor Manual - Version 1.01 Last Updated 08/2025
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Supported Commands

Table 3 below lists the commands supported by the Ammonium Sensor

Start measurement aMm! a05\r\n where 05 = time delay before measurement sent
Send ID al! 14KEYNESCOISELEC Part description assigned by Keynes
Where a = ID number - 0 - 9 (standard) / (a..z) Enhanced SDI-12
0-9/a-zfor RS485
Change Address aAb! where a = Initial address and b = Final address

Make a measurement - a = address of sensor

Address Query 2!

Start Measurement amt Example 1M! starts a measurement for sensor with ID=1

Set Output Variables XCSTRO Sets the parameter order for measurements sent from the sensor - factory set BCDM
Read Serial Number aXSN! Instrument Response a+Serial-number

Calibration Date aXcD! Instrument Response a+date

First Calibration point (ppm) XCAO Typical value = 103.6 ppm

First point uncompensated (mV) XCA1 Typical Value = 417.95 mV

Second point electrical (ppm) XCA2 Typical Value = 20.7 ppm

Second point uncompensated mV) XCA3 Typical Value = 348.45 mV

Temperature Compensation % per Deg-C XCA20 Typical 0.25 % per/Degree C
Table 3

Device List

Figure 44 shows the ‘Device List’ Tab in QLog for a seven port multiparameter housing. Depending on the ID numbers assigned for the
various sensors then this table can vary.

Each individual sensor must have a unique ID/ Address assigned. The Ammonium sensor in Fig 44 has ID = 4.

All sensors identified on a network are listed here.

|87 Olog Recorder - [} *
Qlog View Edit Help s
u b

Device List Variable List Formulas Alarm Levels

List of devices

0 -

.

2

B 3113 14KEYNESCOFLOURS0128CDOMOD02 CDOM/FDOM sensor D.H Setup | Cenfig | IDv14

4 AI1414KEYNESCOISELECT17AmmoD003 ARGES Ammonium ..M Setup | Cenfig | IDv14

5 51!514KEYNESCOFLOURS018Turb0002 Turbidity M.R Setup | Cenfig | IDv14

6

7

5

Logging N Stopped at 18:16:35

Figure 66

To assign the parameters in the results table correctly simply select the ‘Auto-Assign’ option from the QLOG menu list.
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User Calibration

To select the User Calibration mode sensor operation

The simplest way to calibrate the sensor is to use the QLOG software and switch the sensor into calibration mode
Measurement mode is when the sensor is returning the real-time measurements such as

Raw concentration (ppm),

Temperature Deg-C,

Temperature compensated concentration (ppm),

raw sensor reading in millivolts

as defined in the output variables, see table 2, parameters AMEG

Press the ‘Setup button’ as shown adjacent to the sensor shown in Figure 67 below,

CH Qlog Recorder

Qlog View Edit Help
u

Fyrd

Device List Variable List I Formulas I Alarm Levels

List of devices

A4 14KEYNESCOISELECTT17AmmeDD03 WRGES Ammonium .M Setup | Config |IDv14

SR

Logging N Stopped at 18:16:35

Figure 67

Two menu options are available for selection
1.  Ammonium Sensor
2. User Configuration

Select the ‘User Configuration’ option

B Device Setu 4 ES = .
. P B Device Setup ? X

Device ID I o Device ID lﬂ'—

Configuration Configuration

IUser calibration j

IAmmonium Sensor j

Start Column Start Column

o | o R4

— -

Figure 68 - Measurement Mode Figure 69 - User Calibration Mode

The output variables AGME shown in table 2 are only returned in measurement mode. If measurements are taken in user calibration
mode then the results returned may be incorrect or wrongly identified.
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The Sensor Configuration Window shown in figure 70 will appear

=

[ Edit Sensor Configuration 7 x
Property Value tool Set
dentify 14KEYNESCOISELECTT7Mitr0003
Probe Type Mitr*|SELEC;0 Tool ~f Set
Serial number 0003 Tool ~f Set
Minimum underrange 1.00000 Tool ~f Set
Maxirnum overrange 1200.0 Tool ~f Set
Cutput variables AMGE Tool ~f Set
Maolecular ion mass g/Mol 1.0000 Tool ~f Set
Scale mg/L to ppm 1.0000 Tool ~| Set
First point millivolts 321.00 Tool ~f Set
First point pprm 97.000 Tool ~f Set
Second point millivolts 260.00 Tool ~f Set
Second point pprm 970.00 Tool ~f Set
Secondary scale factor 1.0000 Tool ~f Set
Tertiary scale factor 1.0000 Tool ~| Set
Calibration Temperature Deg-C 22,000 Tool ~| Set
Temperature Correction mV/Deg-C 0.75000 Tool ~|| Set

Figure 70 - Ammonium Sensor Configuration Window
The user can adjust some but not all of the parameters in this window; Identifier String, Product Type, and Serial Number cannot be
adjusted. All of the other parameters can be changed by the user.

Enter each new calibration factor into the table, store the values with the ‘Set’ Button. When using a Keynes Controls media converter
the status lights will flash briefly, showing the parameters have been sent to the sensor.

After completing sensor calibration the user should switch the sensor back to the normal mode of operation.

Arges Ammonium Sensor Manual - Version 1.01 Last Updated 08/2025
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Measurement Mode Operation

Once the configuration is complete then the user has to set the sensor to return the standard measurements.

Should the user forget to switch the sensor mode of operation the sensor will return measurements but these may not match defined
units shown in the variable list, or panel meter displays.

1. Close the User Configuration Window
2. Select the ‘Setup’ Button adjacent to the Chloride sensor as shown in figure 67 above.
This is on the Device List tab of the QLOG Software.

3. Select the ‘Chloride Sensor’ option as shown in Figure 68 on page 25

QLOG Charts & Panel Meters

Use the ‘View’ Tab to select and configure the real-time charts and panel meters.
The QLOG software supports up to 4 x dual Y axis real-time charts.

N
(2)
LS
|7 Clog Recorder - ] x
Qlog | View Edit Help b
T
fiey Chartl ist | Formulas | Alarm Levels |
Chart 2
Ul Char3
Chart4 IWIPERADD2wip243101 ARGES Wiper D.D Setup | Config | IDv14| =
f/ri\\ Console ISELECT02Ammo0001 ARGES Ammonium E.H Setup | Config | IDv1.4.
1 )| % |CD Panels *
N/
6116 14KEYMESCOISELECTO06Mitr0001 Nitrite LR Setup | Config | IDv1.4:
|7HTT4KEYNESCOFLOURSOWTrprDDT [Tryptophan Fluor S.AB Setup | Config | IDv1.4
811814KEVNESCOFLOURSD1 TTurb0002 Turbidity AC.AL Setup | Config | IDv1.4.
91'914KEYNESCOFLOURS017Dis 00001 Disolved Oxygen (optical) AM.AQ Setup | Config | IDv1.4:
alla14KEYNESCOFLOURS017CDOMO0DZ CDOM/FDOM sensor WAR.AY Setup | Config | IDv1.4.
=
Logging N  Stopped at 14:27:08

Figure 71

1 = Panel Meter Selection
2 = Charts Selection
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Identifying the USB-SDI12-AG1 media converter COM Port Number
Use the Windows Device manager

Select ‘Ports (COM LPT)

a list similar to that shown below will appear

Windows 10 Device Manager Window

’ ‘E ;::'\:‘;:""“” The USB-SDI12-AG1 media converter used in the examples above is identified as USB
’ Serial Port (COM 3) as shown in the image opposite.

> fH) Human Interface Devices
» =@ |DE ATA/ATAPI controllers
> Keyboards
» ﬂ Mice and other pointing devices
» O Monitors
> I Network adapters
~ ¥ Other devices
Bi PClEncryption/Decryption Controller
v @ Ports (COM & LPT)
ﬁ Communications Port (COMT)
i USB Serial Port (COM3)
» [ Print queues

Figure 72
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